Welcome to The Art of Digital Blending. This course is protected under copyright law. It is illegal to copy or distribute any part, or all of it, without the express
permission of Jimmy McIntyre (2014).
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1. Introduction To The Art of Digital Blending

Hi and welcome to this comprehensive digital blending course, teaching luminosity masks. My name's Jimmy McIntyre and I'm a travel photographer,
specializing in digital blending and advanced HDR.
In this course you'll learn some of the most powerful techniques for making specific changes to your images, and how to blend multiple images to create
stunning photos, without HDR software.
Here, you will learn how to create and use luminosity masks in a completely non-destructive, highly advanced digital workflow.
We'll start with the very basics and work up to advanced blending so that in the end, you'll have at your disposal a professional workflow, capable of
creating world class photos.
Now, as with everything in photography, luminosity masks aren't perfect. We can't use them with every image, but with time you will get an intuitive
understanding of how and when to use them effectively.
All of the images you see here have received luminosity mask treatment. But luminosity masks don't guarantee perfect images. You must capture beautiful
subjects and sharpen your knowledge of composition and light. Then, with this advanced workflow, you will begin to create images that amaze people.
This course assumes you some knowledge of masking and basic Photoshop processes. However, if masking is completely new to you, I've also included a
quick tutorial explaining what masking is and how it applies to your workflow.
Finally, you may find luminosity masks difficult at first. They aren't the easiest thing to learn, but it is absolutely worth your time and patience in the end. If
you have any difficulties, please feel free to contact me on facebook under Jimmy McIntyre or on my blog, throughstrangelenses.com.
For now, I wish you the best of luck for this course, and I look forward to seeing your beautiful digitally blended images online.
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2. What Are Luminosity Masks?
To begin our digital blending journey, we must first understand what luminosity masks are.
Essentially, luminosity masks are a selection tool. For example, we have the lasso tool, where we can make a quick, free-hand selection, like this.
Now we can paint, or do any adjustment, only in the selected area.
Or we can use the more intelligent, Quick selection tool to make an accurate selection of the sky above the mountains.
Both of these selection tools are very useful, but in digital blending, we often need more precise selections.
Our images are made of many different luminosity values. In other words, there's often a huge range of highlights, shadows and midtones in our photos.
Unlike any other selection tool, luminosity masks target only brightness values. They are the most effective way of making accurate selections of highlights,
shadows or midtones. But why is that important?
Well, if we look at this image, we can see that the sky is too bright and it lacks colour. If we darken the sky, we can fix this and give the image greater mood.
One way of doing this is through a simple curves adjustment layer.
If we open curves layer and place three points at the bottom to keep these darker tones unaffected, then we can use this hand to select a bright area on the
image and drag down to darken that area. You'll see a new point added to the curve and the sky has darkened. But it clearly doesn't look natural. Delete
this layer.
The other method we can use is through the Quick selection tool, as we've already seen. I'll run this across the sky, and we have a fairly accurate selection.
But if I open up a curves layer and begin to darken the highlights, you'll notice that the mountains start to look extremely out of place. They are too bright.
Let's delete the layer.
We can change this so that we can include the sky and the mountains in the selection. With a new curves layer, we can once again bring down those
highlights. But now we can see three problems.
Firstly, the mountains in the background are becoming too dark. Secondly, we can see some strange areas which the quick selection tool has missed. And
finally, if we zoom in, it's obvious the selection is extremely unclean, and certainly not good enough for your imagery.
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To make a truly accurate selection of the sky and mountains, we only need to use a very basic luminosity mask. So if we go to our Channels Palette, we'll
see 4 thumbnails, RGB, Red, Green & Blue. Later, when we create our advanced luminosity masks, this is where those masks will be found.
But for now, we can actually use any of the Red, Green or Blue channels as a basic luminosity mask. Without going into too much detail, let me quickly
demonstrate to you how luminosity masks can easily make the selections that we are looking for.

Firstly, I'm going to choose the channel that has the greatest amount of contrast, which seems to be the Red channel. Next, I'm going to hold CTRL on a PC
or a CMD on a Mac, and left-click on the Red channel thumbnail. You can see marching ants appear. This is our selection. Now I'll go back to the Layers
panel and select one of the layers – it doesn't matter which. If you don't select the layer first before opening up any adjustment layer, the screen will go
pink. If you're trying to choose the Background layer, it may be locked, in which case double-click on that layer to unlock it.
Now I press CTRL + H, or CMD + H on a Mac, and this will hide the marching ants, but the selection will still be active.
This time, if I open up a curves layer, you will see a mask is immediately applied to the curves layer, and it looks identical to the Red Channel, which we
based this mask on. To look at your mask, hold down Alt, or Option on a Mac, and left-click on the mask. Click on the layer below to return to the view of
the main image.
Now if I open the Curves layer, you can see by the histogram that none of the darker tones will be included in this adjustment, so our foreground will be
protected from the changes.
As I bring down the curve, the sky darkens beautifully, and so do the mountains. But they haven't darkened too much, like we saw with the quick selection
tool. In fact, they've darkened directly in proportion to the sky, so everything looks natural. And if we zoom in, there are no unclean selections on the
horizon. And the already dark foreground is protected from the adjustment.
So the question is, how do luminosity masks work?
Let's move over to a different example now. Here we have two layers. A yellow layer on top with the word Hello, and a blue layer hidden on the bottom. I'm
going to choose the Rectangular marquee tool and make a simple selection.
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Now I'm going to mask out this selection. Just as we saw earlier with the lasso tool and the quick selection tool, we have a strong edge. There isn't a smooth
transition between the two layers. If we look at the mask, we see only black and white.
This time, however, I'm going to use the gradient tool instead of a marquee tool. I'll create the mask by running the gradient tool down the image and you'll
see that there is now a smooth transition between the two layers, instead of the harsh transition we saw before. This time if we look at the mask, we can
see a whole range of greys.
At the top we have white, so this area is completely visible – in other words the yellow layer is visible.
At the bottom we have black, leaving only the blue layer visible.
And where we see our grey scale, that is where the smooth transition begins. The lighter the grey, the more visible the area. The darker the grey, the less
visible the area.
This is where the power of luminosity masks is. Since luminosity masks only make selections based on brightness, we can tailor these selections perfectly to
the image we're working on. We don't just work with black and white masks – our masks are a complex collection of tones that cover the entire
monochromatic scale. We can make smooth, natural changes because luminosity masks are created according to each pixel in our image.
So let's go back to our mountain and look at the mask we created.
We really wanted to darken the sky and some of the mountains. The mask has done that perfectly for us. Since the sky is brighter in the mask, it will
experience the strongest effect of the curves layer. And since the mountains are darker than the sky, they will experience a smaller effect, but they will still
be affected. And that is why the change looks natural. And since the foreground is extremely dark, it's barely affected.
Let's take this a step further and brighten our shadows. To re-select our previous mask, we just hover the mouse over the mask of our curves layer, hold
down Ctrl, or CMD on a Mac, and left-click. We now have our selection as before. However, since this mask targets mainly the highlights, but we wish to
affect only the shadows, we need to invert this selection. We can do that by going to Select>Inverse.
Now we can open up another Curves layer. This time the mask looks very different.
The darkest areas are now bright, and selected in our mask, while the brightest areas are now dark, and won't be strongly affected by the adjustment.
But if I open the curves layer and raise the shadows, the mountains in the background will be affected slightly.
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To prevent that, I simply choose the hand and select an area on the mountains. This has created a point along our curve. Now we can raise the curve left of
this point, to raise the shadows. And again, our changes look smooth and natural.
So these two simple Curve adjustments have given us a much more balanced image, with greater mood and more information in the darker and brighter
areas.
This is a complex subject which will become clearer as this course moves on, and you see more and more examples of luminosity masks at work. In the next
video, we will create more advanced luminosity masks that can target even more precise selections.
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3. How To Create Luminosity Masks

In this tutorial, we're going to create an advanced set of 18 luminosity masks.
To create luminosity masks, we need to go to our Channels palette, where we'll see RGB, Red, Green & Blue channels. Hold down Ctrl, or CMD on a Mac,
and left-click on the RGB thumbnail. This will generate a selection, just as you saw in the last video. Now we go down to the Save selection as channel
option and click on it. You will see a new channel appear, called Alpha 1. This is your very first luminosity mask, which will target brighter luminosity values.
If you find that your luminosity mask looks different to mine – that it has become inverted. Go to Edit>Undo and this time go down to the Edit in Quick
Selection option and click on that.
Make sure you have Masked Areas selected. Now it should work for you.
Next, we must refine this mask to make it more specific. In other words, to make it more targeted towards brighter areas, while restricting darker areas. We
do this by multiplying our selection. If you no longer see the marching ants hold CTLR, or CMD, and left-click on the Alpha 1 thumbnail to regain them. Skip
that step if you still see them.
Now hold down Shift, Ctrl & Alt, or Shift, CMD & Option on a Mac, and left click on the Alpha 1 thumbnail again. You will see the marching ants change.
Again, click on Save selection as channel. This will automatically be called Alpha 2. Clicking on Alpha 2 we can see that the mask is generally darker, but that
the highlights have become brighter. Compared to Alpha 1, this mask would create a finer selection, targeting the brighter areas while excluding more of
the shadows and midtones.
To continue refining our masks, we can do this again. Hold Ctrl and left click on Alpha 2 to make the selection, and now hold down Shift, Ctrl and Alt, and
left click on Alpha 2 again to multiply it by itself. Our marching ants will change and we can save this selection as Alpha 3.
You'll see that each new channel is becoming darker and darker, while the highlights are becoming stronger. Each channel, as we continue, will allow us to
hone in more accurately on the brightest parts of our images, while excluding darker tones completely.
Let's do this 3 more times, so that we end up with 6 alpha channels.
Now that we have covered our full range of bright channels. It's time to start creating masks that will target the darker areas in our image.
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To do this we must press Ctrl + D, or CMD + D, to deselect our selection and return to the RGB channel. Once more we'll hold Ctrl and left click on the RGB
channel to make a selection. This time we need to invert this selection. Go to Select>Inverse.
And as before we'll Save the selection as a channel. Now we'll see an inverted mask, which has blacked out our highlights while brightening our shadows.
This new channel should be called Alpha 7. We are going to refine this mask just as we did with our bright channels.
You should still see the marching ants from our new channel. Again we'll hold down Shift, Ctrl, Alt, or Shift, CMD, Option, and left-click on the thumbnail of
Alpha 7. Our marching ants will change and we'll save this as a channel.
This, just as with the bright channels, has refined our mask, but this time we are targeting our darker areas while removing more and more highlights from
the mask. Let's do this just as we did with the bright masks previously, until we get to Alpha 12.
Now we have masks that cover the entire range of our highlights and shadows, it's time to create masks for our midtones.
We've been making more advanced masks by multiplying our selections. This time we'll be subtracting selections. To create midtone masks we first must go
to Select>All, or press Ctrl + A. Marching ants will appear around the screen. This means everything in our image has now been selected.
Now go down to the Alpha 1 channel, hold Ctrl & Alt, or CMD and Option on a Mac, and left-click on the Alpha 1 thumbnail. You've now subtracted the
highlighted areas in that channel from our current selection. Next go down to Alpha 7, our first Darks mask, and do the same, Ctrl, Alt & left-click. This will
now subtract all of the highlighted areas in Alpha 7 from our current selection. Now let's save this as a channel. If you see a dialogue appear, simply press
Okay.
We now have our first midtones selection. This should be called Alpha 13. If we click on it, you'll see that both the highlights and shadows are dark, while
the midtones are more visible. Let's refine this further.
Start again by pressing Ctrl + A to select all. Now go to Alpha 2 and subtract this mask, by holding Ctrl + Alt, or CMD + Option, and left-clicking on the Alpha
2 thumbnail. Now do this with Alpha 8, and save the selection. This channel will be Alpha 14.
As you can see we are subtracting a brights channel, and the corresponding dark channels. Let's do the rest.
Finally, now that we have all of our channels created, we can name them appropriately. The bright masks will simply be Brights 1 through to Brights 6. The
Darks will be Darks 1 to 6, and finally the midtones will be Midtones 1-6.
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And that's it! We've now created our full range of luminosity masks.
Now I'm going to show you how to install my luminosity masks so you don't have to go through this process each time.
Firstly, locate the Actions folder. Inside you'll see all of the actions that come with this course. Copy them into a folder of your choice. Now you can simply
double click on each ATN (action) file to open them in Photoshop.
Or you can go to your Actions dialogue and open them up there, one by one. If you don't see an actions dialogue, go to Windows and select Actions.
Now go to the menu in the top right hand corner of the actions dialogue and choose Load Actions. Find the actions and press Load. The actions are now
ready to use in your new digital blending workflow.
And that's it. With a basic understanding of luminosity masks, and with the actions loaded, you are now ready to move onto a more advanced
understanding of how luminosity masks can fit into your workflow.

10

4. Making Specific Adjustments With Luminosity Masks
Now that we have our full range of luminosity masks, it's time to see how we can use them in our workflow to make very specific enhancements within our
photos.
As we saw in the first video, we can target areas based on brightness to lower highlights or bring out details in darker areas. In this lesson, we are going to
take that a step further. We'll look at making even more targeted contrast changes, using different masks, including midtones. And in the end, We'll have
given our image more mood and balance.
Firstly, looking at the image we have in front of us, the highlights in the sky are quite strong, but we have no under-exposed areas, which is great.
To begin with, we have to run the luminosity mask actions. Go to your Actions dialogue, and open up the JM Luminance Mask action. Select Generate
Luminance Masks, and press Play. If the actions don't run smoothly in one go, make sure this box is unchecked. If it isn't, uncheck it and start the actions
again.
Our first task is to bring down the highlights, and add some warm colour to that over-exposed region. So we want to target the sky and some of the
foreground water.
Firstly, let's unlock the background image. Now we'll go into our Channels palette and look through the Brights channels.
It looks like Brights 2 will be ideal for that selection, since much of the over-exposed part of the sky is white-ish, and the highlights in the foreground are
light grey, meaning they will only be partially affected by the changes. But the shadows and darker midtones won't be affected, because they are darker in
the mask.
Holding Ctrl and left-clicking on Brights 2, we now see our marching ants. Press Ctrl + H to hide them. Now back to our Layers panel, we can open up a
Curves layer and bring down the curve slightly, which lowers the highlights, and gives the area more colour.
Now we're going to give the whole image more mood by adding extra contrast and colour to the midtones. So the contrast adjustment won't affect the
highlights or shadows in our image, just the midtones.
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Back to the Channels palette, I usually use Midtones 3 for contrast adjustments. This is because it's often the most balanced mask, selecting a good range of
midtones while excluding highlights and shadows. However, at the moment, the highlighted areas and the shadows aren't completely blacked out in this
mask, so they will be affected by any adjustments we make. We can refine this further by subtracting more masks, as we did in the last video.
Select this mask by holding Ctrl, or CMD on a Mac, & left-clicking. Now if we go up to our Darks masks, we need to find a mask that includes all of our
shadows. We're subtracting these from our selection so that these areas remain protected from the contrast adjustment. Otherwise, we may end up with
under-exposed parts in our photos. Darks 4 looks like a good selection. It includes the stack in the background and some of the rocks in the foreground.
Let's subtract this mask by holding Ctrl and Alt, or CMD and option on a Mac, and clicking on the Darks 4 thumbnail.
Now let's move up to our Brights masks. We don't want to influence any of the brighter part of the sky or foreground, so I think Brights 2 is ideal, because
they're fairly bright in this mask. Let's subtract that, just as we did with the Darks 4 mask, by holding Ctrl + Alt and left-clicking on the thumbnail.
Now we have our selection. Return to the layers panel and open up a Curves layer.
Hold alt, or Option on a Mac, and left-click on the thumbnail of your new Curves layer mask. This is the mask we just created, and we can see a lot of
midtones will be selected, but the highlights in the sky won't be affected and nor will the darkest parts of the rocks, because these areas are dark in our
mask. The histogram in the Curves layer confirms this – no shadows or highlights are selected in the adjustment.
We can adjust the midtone contrast by creating a typical S-curve. Or we can create extra contrast by changing the blend mode of this layer. If we change it
to Overlay we get a strongly contrasting scene, which is probably a touch too strong. A gentler effect can be found using the Soft Light blend mode. This one
change has added some lovely contrast and mood. And if you feel the change is too strong, you can always adjust the opacity of this layer to suit you.
Now we've created more contrast within the midtones, let's add some brightness to them too. The image is a tiny bit dark, but again we don't want to
affect the highlights or shadows with this change. Let's re-select the mask we just created by holding Ctrl and left-clicking on the Curves layer mask. We now
have our selection back. This time, we'll open up a Brightness layer. We'll just slide the brightness along slightly to increase the general brightness of the
image.
Now I'm going to group these changes by selecting both layers, and pressing Ctrl + G, and name this group 'Midtones'. This is a before and after comparison.
There's much more contrast and colour now.
You may find you want to deepen the shadows slightly, in which case, we just need to go to a Darks mask, like Darks 4, select it, and open another Curves
layer just as before. We must be careful not to darken those shadows too much. And if we wish, we can mask out some of the changes if we don't to affect
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certain areas. For example, the seastack has darkened too much and the corners of our image have darkened a bit much too. To correct this, choose your
paintbrush, put your foreground to black, set your opacity, and paint over the areas you don't want to be affected by the Curves layer.
Now we've produced 3 targeted contrast adjustments with luminosity masks and completely changed the feel of the image.
I'm going to group our previous changes, and call this new group Contrast. Now we're going to draw out some detail within our image. In the Actions folder,
you'll see the Detail Enhancer action set. If you haven't installed this, double-click on the action.
Or load it into Photoshop in your Actions dialogue, like so.
We're ready to use our detail enhancer, but it's important to know that any form of detail enhancement will create a number of problems in our images.
Mainly, it will exaggerate any noise in your image. And secondly, it can often lead to white edging around objects. We can often avoid both of these
problems by placing a luminosity mask onto the detail enhancing layer.

Let me show you what I mean. We can run our Detail Enhancer, by making sure we have the main image selected, and then going to our Actions dialogue,
to Detail Enhancer, and selecting Start. Then we just press play for this action to run. This can take a few seconds if you're working on larger files.
The Detail Enhancer has now finished and has created a new layer called Detail Enhancer. You will see that the default opacity for this layer is 38%. We
don't need a high opacity for this to create a good effect. But for this video, I'm going to use an opacity of 60%, so you can see the changes clearly.
I'll make this layer invisible so you can see how dramatically the details have been enhanced. This is because we are making local contrast changes, which
affects contrast at a much smaller level.
But we can see that it has caused a few problems. The seastack now has some untidy edges, the sky now has pronounced black edges around the clouds,
and the water has lost some of its smoother texture.
Just as before, we can tailor this layer to suit our needs using luminosity masks. Essentially, we want to target the body of the seastack, and the foreground
rocks.
Let's look for a suitable mask in the Channels palette. Looking at out luminosity masks, Darks 3 will be a great option for us. It contains much of the
information we need in the foreground, the seastack is selected, and most of the sky will be excluded.
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Let's select this mask by holding Ctrl, or CMD on a Mac, and left-clicking on the thumbnail. Now we'll return to the Detail Enhancer layer in the layers panel.
To apply our selection we just need to go to the Add Layer Mask button at the bottom of the Layers panel and press it. Our luminosity mask will appear in
the Detail Enhancer mask.
Now if we compare before and after, you'll see the changes are much more subtle and only in the areas that interested us. I'm going to increase the opacity
of the Detail Enhancer to 100% just for demonstration purposes.
You can now see the lovely detail being emphasized in the foreground and the seastack. But, we no longer have any of the problems we saw earlier. The
seastack is free from untidy edging, and most of the sky and water is unaffected. Our luminosity mask has taken control of the detail enhancing effect and
left us with a much more pleasing image.
We can see what the layer would look like without the luminosity mask applied if we right-click on the mask and choose Disable Mask. The effect is far too
strong and leaves the image looking over-cooked. We can click on the mask again to enable it.
Finally, we're going to look at how to refine our masks even further, to make more specific selections. Let's say that after looking at our image we've
decided that the sunrise is lacking brightness. The beauty of a non-destructive workflow is that we can simply go back to our Curves layer from earlier and
adjust it accordingly. But sometimes we don't have that option.
We could look at our Brights masks to find a suitable selection but on this occasion the masks targeting only the sunrise aren't very strong. We have just a
range of greys instead of white in that area. We don't want to choose a different Brights channel because our adjustments may affect other areas that are
included in the mask.
Another great advantage when you're working with luminosity masks is that they are adjustable. For example, we can take a mask like Brights 3 and change
it so that the sunrise is brighter, while excluding the rest of the image.
To do this we need to right-click on Brights 3 and choose Duplicate Channel.
We now see a layer called Brights 3 Copy. Select this and then deselect Brights 3, and this will remove the pink colour from our image.
Now go to Image>Adjustments and choose Levels. Adjusting our sliders, we can slowly begin to narrow down the area we want to affect. As you can see I
now have a completely white sunset area, and some darker greys in other areas which won't be affected or which I can mask out later. Press okay and
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select this mask in the usual way, holding Ctrl and left clicking on it. With this selection, let's open up a curves layer. The histogram shows us that only the
highlights and upper-midtones are selected.
Now I'll move the curve up to brighten the sunrise area.
I can now mask out some of the areas affected on the rocks and sea.
You should note that this way of refining masks is very useful in other situations as well. If you're shooting a model with darkish hair against a light
background, you can make even the finest selection around small, loose hairs this way.
As with all things, every person has their own unique way of using luminosity masks, it is up to you to find yours.
Finally, I'm going to make one more adjustment. This isn't actually necessary in this image but you may find it useful in some of your images.
If we wish, we can add more warmth to our sunset using the mask we just created. We can do this by holding Ctrl and left-clicking on the Cuvers layer mask
to reselect our mask, and then opening a Photo Filter layer.
Going to Warming Filter 81, I'll move the slider all the way along to 100 to show you the effect.
We can see that only the area selected now has a warm color. This is a great way of applying a colour cast without taking away natural colours from other
parts of the image.
Neither of these last two changes were really necessary in this workflow. They were just used for demonstration purposes. So I'm going to delete them.
and drag our Detail Enhancer layer into the Contrast group. Now here's one final before and after to show you how powerfully luminosity masks have
altered this entire image.
In the next video, we'll these techniques, and a few more to editing a Milky Way image.
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5. Milky Way & Luminosity Masks
In this tutorial we're going learn how to enhance a Milky Way image. We'll start to use Adobe Camera Raw to prepare our images. And we'll learn some
new post-processing techniques, while apply some that we've already learned.
To begin our Milky Way tutorial, let's drag the image into Photoshop and open up Adobe Camera Raw. Camera Raw uses the same engine as Lightroom, so
it's great for general RAW file processing. With Milky Way shots, we're going to correct some colour and add more contrast.
Firstly, we want create a nice, dark blue sky and reduce some of these warmer tones throughout the image. Using the Temperature slider, this is extremely
easy. We just move the slider down to around 3,500 and now cooler tones have replaced the warmer ones.
Next we'll bring the Exposure up to 0.5, just to brighten the image because it's a bit dark.
Now we want to emphasise the stars a bit more. The two sliders that affect the highlights in our images are Highlights and Whites. We're going to increase
both to 30. Our goal is to brighten the stars but not to over-expose the clouds you see here and here.
It's important that we draw some detail out of the darker parts of our image because these areas too under-exposed. To do this we'll increase Shadows to
100, and Blacks to 14. These adjustments will create extra noise, some of which we'll be able to correct later.
To give our image a bit more kick, we're going to increase some local contrast. We'll do this by increasing the Clarity slider to 65. You can see this bringing
out more of the stars, but since it's a general adjustment, it will also affect the rest of the image.
To continue increasing the Clarity slider to bring our more of the stars, but without affecting anywhere else in the image, we can use the Adjustment Brush
you see here.
The settings on the right are similar to the main settings, but having the brush allows us to make more specific changes. For example, if we increase
Highlights to around 50, and Clarity to 50, we can now run our brush across the sky and brighten the stars. If you need to change your brush size, scroll
down to Size and adjust it. Make sure your Feather is set to 100 so that we see a smooth transition between the areas we are affecting and the unaffected
areas.
This is all we need to do in Camera Raw. Let's press Open Image and start processing in Photoshop.
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With our image in Photoshop, let's look at some challenges that we face with this scene. Firstly, the stars are nicely in focus and exposed for, despite a bit of
noise in the sky.
However, since the foreground is extremely close to the camera, it's very out of focus. Because we've had to recover the shadows in the foreground, it is
also suffering from a large amount of noise, and purple colour noise. This is inevitable from this type of scene. Ideally, I should have shot a separate
exposure, exposing for, and focusing on, the foreground and then focus stacked the images. Or we could have illuminated the foreground with a torch while
shooting, but I personally don't prefer that method. As it is, I've chosen this image because of these challenges.
Our goals in this workflow are to remove the noise in the sky, deepen the dark tones in the sky, brighten up the Milky Way, and reduce the noise and colour
noise in the foreground. We can do almost all of this with the help of luminosity masks.
The first thing we need to do is to make a selection of the foreground. We're doing this because the luminosity masks will be able to target the stars,
because they are significantly brighter than the rest of the image, but they won't be able to accurately distinguish between the foreground and sky because
they have similar brightness levels.
Let's choose the Quick Selection tool. We're going to run the selection tool near the rocks, but on the side of the sky. This will help to find the rock edges,
but in the end it will select the sky so we then have to invert the selection.
To invert the selection hold down Ctrl+Shift + I, or CMD + Shift + I on a Mac. Now let's save the selection so we can return to it later. Go to Select and
choose Save Selection. Save this under Foreground.
It'll go in the Channels palette, where our Luminosity Masks are stored.
Our first step is to remove noise. Duplicate the base layer by right-clicking on the layer and choosing Duplicate layer. There are a number of ways to do this.
I highly recommend Topaz Denoise. After using this for about 2 years, I have no complaints at all. It does a great job of reducing noise and avoiding
excessive banding. I'll open up Denoise now.
The only thing we're going to do here is drag Overall Strength all the way to the right, and press Okay.
If we zoom in we'll see the noise has been reduced, but we've also lost information in the foreground, which is extremely blurry. Depending on your image,
and which noise removal program you use, you may also see that your stars have become blurry. In this image they haven't blurred too much. Don't worry
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if your stars are blurry. We're now going to create a luminosity mask to protect the stars from the noise removal layer, and we'll use the foreground
selection we created earlier to bring more detail back into the foreground.
With the base layer selected, and the noise removal layer invisible, run the luminosity masks. Now go to the Channels palette. We are looking to create a
mask that excludes the stars. This is because we're going to create a mask for the noise removal layer that allows all of the shadows to be visible. This will
mean the noise removal will only be applied to the darker areas, and not the stars. Usually this means we'll be working with the Darks masks, since we're
looking to select the darker tones.
However, if we look at the Dark masks, say Darks 2, we'll see it's kind of a mess. It's hard to really know what's included in this selection. It's much easier to
just use the Bright masks. If we look at Brights 2, for example, we can see the beautiful Milky Way, and how bright the stars are in this mask. So we know
that the stars will be included in the selection. And the noise around the stars is a darkish grey tone, which means it will only be partially selected.
Let's use Brights 2 for this mask. Ctrl + left-click to select, as usual. Since we said before that we needed a mask that excluded the stars and included the
shadows, we now need to invert this selection. Let's do that by holding down Shift+Ctrl + I, or Shift+CMD+I on a Mac. Now we have our selection, we need
to further refine this by subtracting the foreground from the selection.
Go to the Foreground channel we created earlier and press Ctrl+Alt and left-click, or CDM+Option and left-click. This should remove our foreground from
the selection and leave us with a mask that only includes the darker sky. We can test this by going back to our Layers panel, selecting the noise removal
layer, and pressing Add new layer mask.
The new mask now looks exactly as we'd hoped. The foreground is blacked out completely, as is the Milky Way, and the rest of the sky is white, which
means this is the only place the noise removal is being applied to.
If we zoom in it's obvious that there's too much noise in the rocks in the foreground. We can apply some gentle noise reduction to this area by masking the
noise removal layer into this area. Setting our paintbrush opacity to 35% and our foreground to white, you can see that we are reducing some of that noise.
Now if we look at the image, where we once had lots of noise, we now have a much smoother surface.
If you don't have a noise removal program. There is another, slightly less-effective way of reducing noise. Let's duplicate the base layer again and make the
noise removal layer invisible. And this time we're going to go to Filter>Blur>Gaussian Blur. This will simply blur out our noise. Setting the Radius to 4 pixels,
I'm going to press Okay.
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If we zoom in we can see that everything is blurry.
You just need to go through the same luminosity mask process that we did with the other noise removal layer to protect our foreground and stars. Since I
already have this mask ready, I'm just going to drag it onto this new layer, just to show you how it restores sharpness to the stars and restores some of the
foreground too.
Let's put this mask back onto our Topaz Denoise layer and delete the Gaussian blur layer.
Next we're going to draw some details out of the selected areas in the foreground and the rocky hills on the horizon. These areas are just a little bit too flat,
and need some local contrast applied to them. Hopefully this will also help to reduce some of the blur in those areas. We are going to run the Detail
Enhancer, but we need to merge these two layers first, so that we can run the action. To do this non-destructively, we can select the noise removal layer,
then hold Ctrl, or CMD, and select the layer below. Then we can hold down Ctrl+Alt+Shift + E, or CMD+Shift+Option+E. This will create a new layer, which is
our two layers merged.
With this new layer selected we can run the Detail Enhancer. Since we only want this to affect the foreground, let’s go to the Channels palette and choose
our Foreground selection.
Now we'll go back to our Detail Enhancer and Add a new layer mask. Put the opacity of this layer up to 100%. Now we're going to mask much of this layer
out. The main goal of this layer is just add detail in the near foreground, which will enhance the interesting texture of the rocks. And we hope to bring out
some local contrast in the rocks behind. Selecting our paintbrush, setting the background to black, and our opacity to 50%, let's begin masking out some of
those unwanted areas.
The foreground now has some added texture, detail and local contrast, and doesn't look over the top.
It's now time to start adding more drama and mood to our image. We're going to do this by deepening the dark parts of the sky and also some of the
foreground, but not affecting the stars. Fortunately, we already have a mask that will work for us.
I'll select the mask we used on our noise removal, by holding Ctrl and left-clicking. We can see the marching ants that mark our selection. I can now open up
a curves layer and create a typical S-curve to increase overall contrast throughout the image.
We already have more drama in our image from this one change. To show you how important the mask is, I'll right-click on it and choose Disable Layer
Mask. We can see how dark the foreground has become, taking away the detail we've worked to enhance.
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Now let's add a blue tone to the darker sky, to make it more interesting. Firstly, let's reselect the mask we just used, but this time we don't want to have
any of the foreground selected. You can see in this mask that the foreground is grey, which means it will be partially affected by any blue colouring we add.
Let's subtract our Foreground selection from this mask by holding Ctrl+Alt and left-clicking.
There are a number of ways to do this but I'm going to use the easiest way. Open up a Photo Filter layer, go to the dropdown box and choose Blue. As you
move the slider to the right you will see the sky turn progressively bluer. Let's leave it at about 50.
You'll notice that the clouds in the corners have lost some of their colour. So let's mask some of this layer out, so that we can restore their more interesting
colour.
Now that we've deepened and coloured the darker part of the sky, lets brighten up the stars. Return to your Channels palette, and select Brights 2. Brights 1
will include too much of the sky and foreground. And Brights 3 is too restrictive in general.
With our selection made, open up a Curves layer, and bring the curve right up. The stars instantly become brighter without affecting the surrounding areas.
If you want to intensify this effect, just right-click on this layer and duplicate it. Now we have twice the effect. If you feel it's too strong, just change the
Blend Mode of this layer to Soft Light, which gives the stars a much gentler boost.
It's time now to treat the strong colour noise in the foreground. Sometimes when we work with an image, we don't notice problems like colour cast or
colour noise because we're too busy concentrating on other areas. However, there is very distinctive purple-red colour noise that we need to treat. Often
people use heavy noise removal layers to fix this, but that often blurs the image too much for my taste. In our case, we can apply selective colour correction
to get rid of it.
Since we only wish to affect the foreground, let's make our foreground selection. Now we can open a Colour Balance Layer. This is where we will neutralise
that purple colour and try to restore some of the natural colouring of the rocks. In each of the tones we should reduce the red and magenta, while
increasing the yellows and greens a bit. Let's play with these until we are happy.
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If you're happy with your adjustments close the panel. If you didn't see the purple colour before, you will certainly see it now that we have something else
to compare it to. Here's the before and after. We can see a huge improvement.
I personally think the foreground is a little bit too dark right now. We could go back to the Curves layer we created earlier and mask it out. But instead let's
reselect the foreground and create a new Curves layer.
This way we have complete control over how bright or dark the foreground is. Let's lift the curve to brighten this area. That should be enough. And now I'm
going to create a general Curves layer to give the whole scene a slight lift.
That's perfect, except for the clouds which have become a little bit over exposed. Let's mask some of the Curves layer out.
And finally, we're going to create a small vignette to take attention away from the sides of the foreground here, and push the viewer towards the texture in
the foreground. We don't need to apply the vignette to the sky because the corners are already naturally dark.
To create a vignette we'll choose the Elliptical Marquee Tool and set the Feather to 300. Now I'll drag the tool from the top left corner down to the bottom
right corner. This will make a selection, but it will select the centre of the image. Holding Shift+Ctrl+I we can invert this selection and open our final Curves
layer. Bring the curve down slightly in the midtones. You can see it's affecting the sky too much. Choosing a black paintbrush we can now mask out the
areas that we don't want to affect, leaving the vignette only in the foreground.
And that's it! I'll group all of our adjustments, just to show you how far we've come. Our selective adjustments have turned a flat, incredibly noisy, moodless image into a publishable photo.
Once again, we've seen the versatility of luminosity masks. Next, we're going to begin using them in much more advanced way. We'll begin our journey into
manually blending exposures to create beautifully natural images.
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6. Introduction To Exposure Blending
What is exposure blending?
Exposure Blending is a term used when we have taken more than one exposure of a scene, and have blended those exposures in post-processing. We do this
so that we can create an image with a greater range of light than our cameras can capture. This is also known as HDR photography. However, most people
don't consider luminosity mask exposure blending as HDR because it produces far cleaner and more natural results than 3rd party HDR software.
Many people ask how many exposures they should capture. Beginners to exposure blending and HDR, often think more exposures is better than few
exposures. However, it isn't necessarily the number of exposures that you take that's important. The type of exposures that you take matters far more. The
thing to remember is that you must capture the full range of light in that scene within your set of exposures. In other words, your brightest exposure should
contain details in the shadows, while your darkest exposures should contain detail in the brightest areas. Combining these images will give you a balanced
scene with no under-exposed or over-exposed areas.
The number of exposures you take is determined by how contrasting the scene is. Typically, I shoot 5 exposures and then use between 2 and 4 in the
blending process.
To give you a visual example of what we're talking about, in this scene we only have to exposures. Our darker exposure on top has a great deal of
information in the sky and water – and has no over-exposed areas. But the foreground is too dark. Our brighter exposure, on the other hand, has a good
level of detail in the foreground, but the sky and water is over-exposed.
By blending just these two exposures, we can take the sky and sea from the darker exposure and replace it with the same area in the brighter exposure. And
we'll finish with a balanced image which contains information in the sky, water and foreground.
The wonderful thing about luminosity masks is that, unlike 3rd party HDR software, we do not alter the original images in anyway. Often our HDRs end up
with terrible noise, over-saturated colours or exaggerated Chromatic Aberration. But by manually blending exposures this way, our results are clean and
natural.
Which Exposure To Run Luminosity Masks
An important question when creating luminosity masks is, which exposure do we run the luminosity masks on? Our masks will look very different depending
on which exposure we create luminosity masks. Since we can only run the masks on one exposure, we have to decide which one will fit our purpose. There
is no definite rule for this. It depends entirely on your aim and the exposures you have available to you.
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Since we're trying to make a selection of a given area, the first thing you must do is find the exposure which will give you the best selection of that area. For
example, I have 3 exposures here. I want to select the sky in order to blend in the darker exposure. I can't use the darker exposure because the sky is too
dark. Let me show you what I mean. I'll make the two other exposures invisible and run the actions on the darker exposure.
Looking at our masks you can see that the sky has various shades of grey in it, which means it won't be completely selected. Let's delete these masks.
Now let's we run the masks on the brighter exposure.
The sky is completely white, but so are the canyons in the background. We need these canyons to be partially grey to make sure the blending process is
natural and smooth. You'll see the full workflow for this image in a few videos, which will clear this point up.
So finally, we'll run the luminosity masks on the middle exposure. Now the sky is almost completely white, while the canyons are partially grey, which makes
this selection perfect. Often, when you're working with 3 exposures like this, the middle exposure is the best exposure to use since it usually has a balance
of over-exposed areas and under-exposed areas. Because of this, we also use the middle exposure as our main exposure, and just blend in parts of the other
2 exposures.
However, you'll see in each workflow that the process is flexible. You can run multiple sets of luminosity masks on multiple exposures for different effect.
You can even create luminosity masks from exposures that you won't use in the blending process.
Ultimately, we may have to try a couple of exposures before we get the right luminosity masks. And as time goes on, with more and more practice, you will
get an intuitive feel for which exposures to base your luminosity masks on.

Finally, once we've created our masks, we need to know how to choose the appropriate mask for the blending process.
Like everything else, it depends entirely on your image. Generally, when I make normal adjustments, like a contrast adjustment, I will use a more targeted, or
restrictive mask, so that I only affect very specific areas. However, in exposure blending, we need to create a smooth transition between exposures.
Sometimes this is easy, but sometimes when our exposures are extremely different in terms of brightness, it is more challenging. So I often use a less
restrictive mask so that when I blend in certain areas, there's a smooth transition between those areas and the surrounding areas.
At the moment, this information probably doesn't mean much to you. But throughout each workflow that follows, I will show you which mask we should
use and tell you exactly why that particular mask works. In the end, you will have a far stronger understanding of which masks to use across different
23

situations.
There's much trial and error in working with luminosity masks, but after a while things become a lot easier, and you find the blending process usually only
takes a few minutes. And in the end, you'll be glad you learned the technique.
The next video is the first in the exposure blending series. I highly recommend that you follow along using the images included so that you get a true feel for
the whole process.
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7. Basic Exposure Blending Tutorial
Welcome to the first exposure blending tutorial in this series. We're going to cover the basics of exposure blending in this tutorial, and re-apply some
techniques you've already learned, but this time in a different scene.
To begin with, in the folder for this video you'll see two exposures, Over and Under. Select both of them and drag them into Photoshop. They'll open up
separately. Choose the move tool in the top left hand corner, go to the Under image, left-click and drag it onto the Over image. Now close the Under image.
If the images aren't straight, use the move tool again to line the top layer up. Unlock the background layer by clicking on the padlock or by double clicking
on the layer.
The order you place the exposures isn't greatly important. Generally I place the brighter exposures below the darker ones. If I'm working with 3 exposures, I
will place the medium exposure as the background layer. We're using 2 exposures here, so I just need to place the bright exposure below the darker one.
To begin the blending process we first need to know which areas we want to blend in each exposure.
On the under-exposed image, we have fantastic detail in the sky and the water along here. But the foreground is too dark. However, on the over-exposed
layer, the foreground is perfectly exposed for while the areas in the sky and water are completely blown out. We need to blend the sky and sea from the
darker exposure, with the foreground from the lighter exposure, to create a balanced image.
We could try masking in these areas with a normal paint brush, but our sticks in the foreground become too underexposed. Luminosity masks will allow us
to make a selection that will exclude the sticks when we blend in the sky from the darker image.
Now that we've targeted the areas we want to blend, we have to create some luminosity masks. The best exposure to use for this is the brightest one. But
let's create luminosity masks on the darker exposure to show you why.
Remember that we want to isolate the sky and water from the foreground. This means we want the foreground to be dark in the mask, and the sky and
water to be bright in the mask. In our Channels palette we can see that our masks don't offer us the selection we're looking for. In the Brights channels
neither the sky nor the water is bright. In fact, there areas are almost the same as the foreground, which is only a little bit darker.
Let's delete these masks and create some new ones on the brighter exposure. We have to make the dark layer invisible, and now we can run our masks
again.
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This time we can see a huge difference when we look in our Channels palette.
The sky and water in the first 2 channels is almost white, with some light grey. If we choose the Brights 1 mask, it won't be targeted properly because the
foreground and the sticks in the water are not dark enough. They'll be too affected during the blending process. We'll blend the exposures with this mask
first, to show you what I mean.

Go back to the layers palette first and create a black mask on the dark exposure to make it invisible. You can do this by holding Alt, or Option on a Mac, and
pressing the Add layer mask button at the bottom. We are doing this because we are using the brighter exposure as our base exposure and we're going to
blend the darker exposure in.
Go back to the Channels palette and create our selection by holding Ctrl, or CMD on a Mac, and left-clicking on the Brights 1 thumbnail. Press Ctrl + H to
hide the marching ants. Go back to our dark layer, select the mask, make sure the paintbrush is selected and that your foreground colour is set to white.
Make your brush size big enough and your opacity 100%.
Now begin painting the water and sky into the darker exposure. Go over these regions a few times to strengthen the effect. Zooming into the water, you
can see that the sticks have become darker and have lost contrast. Holding Alt, or Option on a Mac, and clicking on our mask, it's easy to see why this has
happened. The sticks in this mask are a bright grey, so as we paint in the sky and water from the darker exposure, we're also painting in the darker sticks
too, from that exposure.
Let's undo this by pressing Ctrl + Alt + Z, or CMD + Option + Z, until we have our black mask again.
Returning to the Channels palette, Brights 2 would offer us a better selection. But some of the sticks still have a lighter grey tone and so will be affected
slightly.
Brights 3 is a lot better. Most of the sky is bright, while the foreground is nicely dark and will be excluded by the mask. Let's choose this by holding Ctrl and
left-clicking. Hide the marching ants.
Going back to our mask we'll paint over the bright areas once more, multiple times.
This time you'll see the sticks haven't become too dark, but they do look a bit strange.
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This is one very important point that you must remember. We can't simply place one very dark exposure on top of one very light exposure. The difference
between the exposures is too strong. It's the same principal as placing a night sky over a day time cityscape shot in Photoshop. To our minds, it just doesn't
feel right.
That is why in some situations it is better to blend with 3 exposures, in which a middle exposure bridges the gap between the other two exposures – making
things much smoother. I don't want us to jump ahead of ourselves yet. You will see more about this in the Mesa Arch tutorial which does use 3 exposures.
For now, we are in a fortunate position with this scene. There is a way to blend these two exposures that will result in a more natural feel. We can simply
change the opacity of our brush to 50%, change our foreground colour to black, and start masking the water back from the brighter exposure.
The brighter water gives the image more energy and also creates a smooth transition between the two exposures. That looks much more natural.
To make sure we've masked all of the sky press Ctrl +D to deselect the mask, change the foreground colour back to white and the opacity back to 100, and
just paint freely across the top.
We don't need a mask here because there's nothing to select. Now let's look at the before and after. We've completely recovered the sky, smoothly
brought the highlights under control in the water and protected the foreground from the blending process. In other words, we now have a balanced image.
We can merge these two layers now by holding Ctrl+Alt+Shift+E, or CMD+Option+Shift+E.
And selecting the bottom two layers, we can now group them, and call this group Blended.
With our merged layer, we can now begin further post-processing. The first thing we can do is add some detail to this foreground. With the merged layer
selected, run the Detail Enhancer as we did in a previous tutorial.
This new layer has added more detail throughout the image, but we only want it to affect the foreground, not the sky or sea. So we can create a mask that
will apply this layer only to our selected areas.
In our Channels palette, it looks like Darks 2 would make the ideal selection. Almost the entire foreground is white, while the sky and sea are black.
Therefore only the foreground will have Detail Enhancer applied. Holding Ctrl and left-clicking, we select this mask, go to our layers panel, select the Detail
Enhancer layer, and choose Add layer mask. The luminosity mask is automatically applied to the Detail Enhancer.
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I'll increase the opacity of this layer to 50%, for demonstration purposes. Looking at the sky you can see that it is unaffected by this layer, but the
foreground has now had some nice local contrast added to it.
Next we'll give the scene more life by increasing contrast in the midtones. Let's go to our Channels palette. As we've done before we can use either
Midtones 3 or 4 because both have a good selection of midtones highlighted. We'll use Midtones 3. Since we don't want to deepen our shadows too much,
we have to subtract some of the shadows in the sticks in the foreground. Otherwise these areas will become too dark.
With Midtones 3 selected, we can go to Darks 5 and subtract that by holding Ctrl+Alt, or CMD+Option, and left-clicking. We're doing this because Darks 5 is
subtracting only the very darkest areas of the sticks, so these areas will now be excluded from the mask.
The sky in Midtones 3 is already blacked out so we don't need to subtract a Brights selection. With this selection we can now go back to our layers, click on
the top layer, and open up a Curves layer.
We'll create a typical S-curve to increase contrast. None of the darkest or brightest areas are affected by this, and we now have more contrast in the
midtones.
By default, the contrast adjustment has also increased the saturation of our image. Sometimes this works well, but on this occasion, our image doesn't look
great with added saturation. A wonderful technique for keeping contrast adjustments without affecting colours is to change the Blend Mode of the contrast
layer to Luminosity. And now we have our colouring back to normal, but our image still has that added contrast. If you find the contrast adjustment too
strong, just adjust the opacity to suit you.

I feel that the sky is a little bit too bright. By darkening it, we can add extra drama to the overall image. The movement of the clouds is a strong focal point
of this scene, so we should emphasise this area a bit more. We've already created the ideal mask for targeting the sky when we blended our exposures. Go
down to the mask on our darker exposure and reselect it, and open up a Levels adjustment layer. To deepen the midtones in the cloud we just need to slide
the middle arrow to the right slightly. We can also bring the shadows in a bit to add more shadows in the sky.
Finally, to finish this workflow, we'll add a vignette to the image. Choosing the Elliptical Marquee tool, setting the Feather to 300%, we can draw around the
image.
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Invert our selection by pressing Shift+Ctrl+I, or Shift+CMD+I on Mac. Now open up a Curves layer. We can darken the midtones slightly to create the
vignette, which adds a little bit more mood to the scene.
And that is our final image. From now on, the workflows will become slightly more difficult, and the concept of blending exposures has some challenges
that we haven't seen yet. But the whole process will become clearer in your mind each time you practice.
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8. Seascape Exposure Blending
In this tutorial, we're going to look at the biggest challenge of exposure blending with luminosity masks, and one way to overcome this challenge. Using the
Brights channels to restore over-exposed areas is fairly easy to understand. However, restoring shadows in under-exposed areas is a different process, and
requires a different understanding of luminosity masks.
We'll also learn how to deepen the mood of your images, intensify the sunset, add selective warmth and noise removal, and finally add more energy to long
exposure water, like this.
And in the end, we'll go from these Raw exposures, to this final image.
Firstly, we'll begin by preparing our images in Adobe Camera Raw.
Select the darker exposure, and reduce the highlights down to 100. Then select both layers, go to Lens Corrections tab, and choose Enable Lens Profile
Corrections and Remove Chromatic Aberration.
That's all we need to do here, so press Open Images.
In Photoshop, drag the darker exposure onto the brighter one, and close the other window.
We're going to check that these two layers are properly aligned by changing the blend mode of our top layer to Difference. If you see any edging here, like
this, it means the layers aren't properly aligned. To align manually, use your Move tool, click on the top layer, and then use your arrow keys, left and right, to
align the layers.
Or, you can use Photoshop's auto-align function. Unlock the bottom layer, elect both layers, go to Edit>Auto-Align layers, and press Okay.
Before we begin blending the images, we need to straighten the horizon. In order make the changes to all layers, and not just one, we need to link the layers
by selecting both, right-clicking, and choosing Link layers. Now select the top layer. To straighten the layers we could use the Straighten tool, here, and drag
across the horizon. Then we crop it. Or in later versions in Photoshop, we could choose the crop tool and straighten there. But we already have a tight
composition. We don't want to lose any more of the sky in the top left.
So let's straighten the horizon in a different way. Firstly, you must have the Rulers shown. If you don't, simply go to View>Rulers. Now drag the ruler from the
top of the screen down to the left hand horizon. It's very obvious now that the right hand horizon is too high. To straighten this, we're firstly going to zoom
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out so we have a little space to work with. Then we'll go to Edit>Transform>Distort.
All we need to do now is pull this bottom corner down until the horizon is level with the ruler.
Our two layers are now level and aligned with each other. We can begin the blending process. The dark exposure is too dark to run the masks on. There's
very little variation between the brightest and darkest areas. Let's make this layer invisible and run our actions on the brighter exposure.
Previously, we've simply masked in the darker exposure. But this time, we want to use our darker exposure as the base exposure. Everything is fine in this
exposure, and the texture of the water is much more interesting than in the brighter exposure. But some of the areas, such as the rocks, are too dark so we
can mask in those parts from the brighter exposure without affecting other areas. Let's create a white mask on the darker exposure.
Logically, since we can use Brights masks so easily, we often think we can use the Darks masks the same way. But let's see what happens when we do. We
want a mask that excludes all of the sky and much of the water. Brights 2 is perfect for that. I'll select this and just to show you what I mean, I'll blend some
of the brighter exposure into the seastack.
Can you see how strange it looks? It has a kind of hazy look to it. This is because the blending process has flattened the contrast in that area.
If we look at the mask in Darks 2, we can see why.
Remember that in masking, white means that area will be fully selected. And the darker the area, the weaker the selection. In this mask, we are telling
Photoshop to make a full selection of the very darkest areas- these areas are completely white. But the areas around here are different grey tones, which
means they won't be affected as strongly by the mask.
So when we mask in the brighter exposure, we are bringing through the darkest shadows at 100%, the darkest midtones at just less than 100% percent, and
each brighter level along the grey scale is being masked in weakly. This means we are neutralising the contrast in the shadows.
To look at this a different way, if we examine Brights 2, we can see that the luminosity values in this mask are logical. The brightest areas in our image are
also the brightest areas in this mask. The darkest areas in our image are also the darkest areas in our mask.
But in our Darks 2, since we inverted the selection, we also inverted the luminosity values. Our darkest areas in our image are now the brightest areas.
In terms of blending exposures, we have to find a way of restoring some order in the luminosity values of the Darks channels.
Firstly, going back to our layers panel, I'll merge these layers to use as a before and after comparison, and I'll reset that mask to white. This time we're going
to use a technique you're already familiar with. We're going to subtract masks.
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Going back to Darks 2 we'll make our selection by holding Ctrl, or CMD on a Mac, and left-clicking. But this time, we'll go down to Darks 4. In this mask less
of the midtones are selected in the darker areas, and mainly the darkest shadows are selected. We're going to subtract this from our selection, by holding
down Ctrl+Alt, or CMD and Option on a Mac, and left-clicking on the channel.
Or marching ants have changed. We're now going to go to Darks and we'll do the exact same thing, refining our mask again. Finally, we'll finish by doing the
same thing to Darks 6.
Essentially, we now have a darker-midtone selection here, without the darkest areas selected. This means the darkest areas will remain dark when masking,
because they are not included in the mask, but the darker midtones will be brightened during the blending process.
Let's demonstrate this by going to our layer panel, pressing Ctrl+H to hide the marching ants, and masking in some of the brightest exposure. Remember to
have your foreground set to black. We'll paint a couple of times over the seastack.
Now we can compare the flatter image from before with our new image. You can see a huge difference. The rock has retained its contrast, which is exactly
what we're looking for.
I should say at this point, this is the most difficult concept in luminosity masking. Many people don't understand it the first time around. Don't worry about
getting the concept fully. It will come to you with practice. The most important thing is that you know of the challenge this presents you, and now you know
a solution to that challenge. In the next tutorial you will see another way of dealing with this.
For now, let's lower our opacity to around 40, and change our brush to white, and mask out some of the seastack because if it's too bright it may look out of
place.
Returning our foreground colour to black, and making our brush smaller, we can now mask in the brighter exposure in the rocks.
That's the exposure blending step finished, we can merge these exposures by pressing Ctrl+Shift+Alt+ E, or CMD, Shift+Option+E on a Mac. Select the two
base layers, and create group by press Ctrl+G. We'll call this Blended. Let's delete the layer we created earlier.
We have some lens spots or dust sensor to the top left of the screen which we need to clean. With the Spot Healing Brush, and the new layer selected, we
just need to left-click on the affected areas and the spots disappear.
The next steps will help to get the overall colour of the image to where we want it to be. The rocks should have significantly more yellow in them, so we
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need to restore that. We can do this by establishing a 50% grey point. By teaching Photoshop what should be 50% grey in our image, Photoshop then adjusts
the rest of the colours accordingly. However, this will affect the beautiful blue/pink coloring in the sky, which I'd prefer remained the same. We only want to
correct the colours in the foreground.
The first step, we need to create a new layer. We need to fill this layer with 50% grey. Go to Edit>Fill and make sure 50% gray is chosen. Then press okay.
Now we'll change the Blend Mode of this new layer to Difference. Difference compares two layers, pixel by pixel, and whichever pixels are the same on each
layer, they will appear black.
Since we have a blue colour cast over our image, we probably don't have anything that is 50% grey right now. However, with the Difference blend mode, if
we have pixels that are almost 50% grey, they will appear very dark. We can see the darkest parts of our image by creating a Threshold adjustment layer,
moving the slider to the left, and gently moving it back to the right until black speckles appear. These speckles represent the darkest parts of the our image
with the Difference Blend Mode active.
We have to zoom into the speckles and mark that area. We do that by right-clicking on the Eyedropper tool and choosing the Color Sampler Tool. Then we
just left-click on a speckled area.
Now we make the new layer and the Threshold layer invisible and open up a Curves Adjustment layer. In the Curves dialogue you will see three eyedropper
tools. These are used for selecting the white, black and grey points. Select the middle one, which is the grey point eyedropper. And click on our point. The
colours throughout the image have changed and we now have some natural looking colouring on the rocks.
To make sure this only affects the foreground, we can right-click on the Curves layer mask and choose Delete Layer Mask. We can go back to Darks 2, which
we know is a good selection for the foreground, make the selection by pressing Ctrl + left-clicking, and then going back to our Curves layer and creating a
new mask. Just like that, we have removed the blue cast from the water, and rocks, but still have the lovely blue and pink combination in the sky.
Let's remove the Color Sampler point by right-clicking on it and choosing Delete. To do this process quickly, you can skip adding a new layer and a Threshold
layer, and just open a Curves layer and manually select what you think should be close to 50% grey.
One of things I love about this scene is that we've also got some green moss, or seaweed, on the rocks. It adds an extra dimension to our foreground. At the
moment it's a bit dull, so let's give this area some extra colour and life.
Open up a saturation layer and select the hand in the top-left corner. Go down to the green area, click on it, and drag it right. This will increase the
saturation of those colours. In the Saturation layer we can see which range of colours are affected by this change. We can change this by adjusting each
slider, left or right. Make sure the foreground rocks aren't affected. We just want to enhance the greens and some yellows. If we want, we can adjust the
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Hue as well, to something more lively, or eye-catching.
Although we've just colour corrected, we're now going to add a warm filter to the image to increase the mood. Open a Photo Filter layer and leave the
strength at 30.
The problem with warm filters when you have a blue sky is that any blue areas become an unnatural purple colour. I think it would be better to remove the
warm filter from the blue areas of the sky.
We can make a selection of the blue areas of the sky by firstly making our warm layer invisible, and going to Select>Color Range.
In the dialogue, make sure your settings are the same as mine. Check the eyedropper tool to the right, and click on an area of the sky that is blue. Fuzziness
is kind of like feathering. If we have a fuzziness of 0, when we click on a colour, it will select only that colour. But if we increase fuzziness, the selection starts
to include tones that are similar. Put your fuzziness to around 70. You will see that the mask is starting to include other parts of the sky that also contain
various tones of blue. Press Ok to make the selection.
Hide the marching ants, and make the warm layer visible again. Choose your paintbrush, set the opacity to 100%, and the foreground colour to black and
start masking the warm layer out. You will see that it is only removing the blue areas of the sky and nowhere else.
We're now finished with colour control, so let's merge these layers by holding Shift, Ctrl+Alt+E. Select the layers below to group them, and we can call this
group Colour.
The next section will be devoted to various contrast adjustments, which will add life and depth to the image.
The first adjustment we'll make is going to add more energy and drama to the scene. We're going to use Nik Color Efex's Pro Contrast filter to change the
dynamics of the scene, by creating strong local contrast. Let's open up Color Efex. But first, press Ctrl+D to make sure you don't have any active selections.

Open the Pro Contrast filter. It's the Dynamic Contrast slider that will give us the local contrast we're looking for. Slide it to the right to about 65%. If you feel
the highlights and shadows are being too affected by the change, slide them along to the right so that they are protected from the adjustment.
Toggling the before and after you can see a huge difference in the look and feel of the image. Let's press Okay and apply this layer selectively.
The changes from Color Efex look great but they're a little strong. Let's bring down the opacity of this layer to around 60%. We can also create a mask and
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remove certain areas. The blue sky in the top left hand corner doesn't need brightened, and the seastack is also too contrasting and bright. With an opacity
of 100%, a large brush set to black, we can mask this area out.
To increase the mood of the image we're going to intensify the sunset, and darken it. To darken it we'll go to the Brights channels and look for a selection
that includes mainly the sky.
Brights 4 looks great. We'll select that by holding Ctrl+left-clicking, and open up a Curves layer. As we've done before, we'll lower the highlights but try not to
darken the brightest areas too much.
Now we're going to add even more colour to that sunset with a very cool technique. Firstly, we need to select our paintbrush and create a new layer.
Then we'll click on our foreground colour. When the dialogue appears, hover your mouse, which will turn into an eyedropper, over a pink area of the sky.
This will select your foreground colour. Now, with a medium sized brush, paint pink on the new layer in the sunset. Change the Blend Mode of this layer to
Overlay and reduce the opacity of this layer to 35%. Look at how much beautiful colour we've introduced to the sky. Make sure the rock in the foreground
isn't affected by this. If it is, just mask that area out.
Next we're going to give the water in the foreground more life and motion. Merge the layers below, as before, by holding Ctrl + Shift + Alt + E. On this layer,
we're going to dodge and burn the water. Choose the Dodge tool to the left. This brightens selected areas. Make sure you have a medium sized brush, you're
targeting the highlights, and the opacity is at about 10%.
By running the Dodge tool over selected parts of the water, we are now brightening the highlights without affecting the midtones and shadows. Continue
until the effect is quite strong.

Now go to the Burn tool. This time select shadows, and make the brush smaller. Keep the opacity at 10%. We'll paint in the water around the areas we've
highlighted in order to increase contrast and add drama.
One thing you may notice is that some of the water is becoming over-saturated. When we use the Dodge and Burn tools, we affect the contrast, which in
turn increases saturation. As we did in the last tutorial, we can change the Blend Mode of this layer to Luminosity so that we keep the wonderful contrast
without affecting our original colour. A quick before and after shows that we've added some wonderful energy to the movement of the water. We can
change the opacity of this layer or mask some areas out if we feel it's too strong.
I think this image is a little bit too dark in general, so we can open up a Curves layer and brighten the image a tiny amount.
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All of our contrast adjustments are now finished, we can merge these layers again, this time by selecting them all, right-clicking and holding Alt and leftclicking on Merge layers.
Selecting the layers below, we can save them as a group called Contrast.

These are going to be our final touches. But we still have a few things left to do. Firstly we're going to completely change the balance of light in our image.
This one change will alter the entire mood of the photo. Right now, the scene is nicely balanced. But there's too much to look at. We need the viewer's eyes
to be drawn to the beautiful sunset first, then to the foreground rocks and water. To do this, we need to create an advanced vignette that will smoothly
brighten the sunset, while darkening everything else. We can do this in Nik Color Efex again.
The filter we're looking for is Darken/Lighten Center. This immediately changes the balance of light. Choose the Place Center option. This will allow us to
choose where the brightest area will be, which will also dictate where our darkest areas will be. Choose the sky, roughly in the centre of the image, to the
right of the seastack. Increase the Center Size, Brighten the Center Luminosity and Darken the Border Luminosity. It's okay if the effect is too strong. Press
Okay.
Showing the before and after, we've made a huge shift in our image. The eyes are now completely drawn to the bright sunset first. Some areas in the
foreground are a little bit too dark, so I'm going to mask some of it out at about 40%.
One thing I love about this is that it has now started to illuminate the side of the rock slightly, as if the sun is brightening it up. We can exaggerate this by
making a selection of the rock and dodging and burning certain areas. Firstly, merge the layers as before, and go to Darks 2, which we know is a great
selection for the rock, without affecting the sky.

Go back to our new layer, and choose the Dodge tool. With the same settings as earlier, start to gently increase the highlights on the right side of the rock.
The changes will be subtle.
Next, choose the Burn tool and change the Range to midtones. This will darken the midtones while protecting our shadows. Keep gently brushing here.
Now let's look at the before and after. The change is beautiful and subtle. Since the rock is already a brown colour, Dodging it has now made it look like it has
been warmed by the sun.
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Looking at the sky we have a little bit noise, that isn't a big problem, but for good practice, let's apply a luminosity mask noise removal layer. Let's go back to
our Chanels.
To select only the sky, we should be good with a Brights 3 mask. Select that by holding Ctrl+left-clicking, and duplicate the layer. Open your noise removal
program of choice and apply enough noise removal to smooth out the speckles. Since our mask is active, it will only affect the sky.
Before we finish, we have to clean up an artefact of our preparations in Adobe Camera Raw. Down the side of the seastack, there is a white edge. This was
once purple chromatic aberration, that we removed in ACR. Usually, ACR does a good job of removing this but this time we're left with this white line, which
is fairly easy to clean up.
Zoom out and then go to the Quick Selection tool. With a brush size of around 65, brush on the rock, so that the selection is made of the rock and not the
sky. Once you've made the selection, invert it by going to Select>Inverse. Press Ctrl + H to hide the marching ants and zoom in to the edge.
Choose the Clone stamp and with an opacity of 100, clone an area extremely close to the bottom of the rock, by holding Alt on a Pc, or Option on a Mac,
and left-clicking. Now move left to the rock and press the left mouse button. Drag this all the way up the rock. You will see the edging disappear.
When you get to the top, do the same and drag along. We don't need to do this on the left side as there is no edging there.
For our final step, we're going to add a vignette to darken some of the edges and increase the mood more. Let's choose the Elliptical Marquee tool again, set
the feather to 300, and drag across the image. Invert the selection.
We don't want to darken our darker tones in the foreground, or the seastack, so let's subtract a Darks mask from this selection.
Darks 2 looks like it would be perfect for excluding all of the seastack and the foreground. Let's subtract this by holding down Ctrl+Alt, or CMD+Option on a
Mac, and left-clicking. Our marching ants will change. And now we can open a final Curves layer and create the vignette. We can group these final layers
and call them finishing touches. Let's group these groups for a quick before and after.
Before our image was flat, dark, devoid of real colour and life. After, our image is full of life and mood. These changes have made an incredible difference
and we've learned one technique for overcoming a challenge when blending in the darker masks.
In the next tutorial, you will learn another, equally effective way to overcome this challenge.
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9. Long Exposure Cityscape
In our last tutorial we looked at a way of subtracting dark masks so that we could overcome the challenge of bringing details into underexposed images. In
this tutorial, I'm going to show you another method of doing this, which I often prefer.
As usual, let's begin by dragging our exposures into Photoshop. Select the under-exposed image in Camera Raw. We'll use this as the main exposure. We
need to bring the highlights in the sky down, because at the moment it's too bright. We can bring the Highlights down to around -45.
Select all three layers, go to Lens Corrections, and enable Lens Profile Corrections and Remove Chromatic Aberrations. Click Open Images.
Select the Move tool and drag the underexposed image on top of the brighter image, and then place the blue hour shot on top of them. Now close the open
windows.
We're going to use the blue shot just for the city lights which we'll blend into the long exposure sunset. We can make that invisible now.
The exposures should already be perfectly aligned, but we'll change the Blend Mode of the darker exposure to Difference, just to check. Yeah, there's no
edging, so our layers are fine.
Now we'll straighten our image. Zooming into the bridge we can see that it isn't straight.
Neither is the building to the left here. Let's link our layers so that all of them will be affected by the adjustment/ Select the layers, right-click and choose
Link Layers. Now select just one of the layers.
Go to your crop tool, choose straighten, and run it along the bridge. It will straighten and crop the image. If you're using an older version of Photoshop, go to
the Straighten tool and do the same thing. You may have to crop manually, depending on your settings.
Just as in the last video, we're going to create the luminosity masks on the brighter exposure. We want to be able to select the buildings, while excluding the
sky. Since there isn't much variation in brightness between these areas in the darker exposure, we won't be able to make that selection.
But on the brighter exposure, the sky is distinctively brighter than most of the buildings, so we should be able to create a good selection with this. We'll
unlock this layer and run our luminosity masks. Then we'll create a white layer mask on the darker exposure.
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Last time we selected Darks 2 and subtracted 3 darks masks so that we only included the midtones within our darks for the blending process, and that way
retained our shadows. But you'll remember that the main problem with using the Darks masks was that the brightness levels were inverted. So in our masks,
the darkest areas were completely selected. This flattened the contrast in the blended areas. Even when we subtracted the darker masks, the midtones we
were left with were still inverted.
Let me show you what I mean. I'm going to make a selection from Darks 2, and subtract Darks 4, Darks 5, and Darks 6.
Now I'll open a curves layer, and we can look at the mask we've created.
Since the midtones are inverted it looks like an old-fashioned negative.
But let me show you something different. I'm going to select Midtones 3, subtract Darks 4, Darks, Darks 6, and Brights 4. With this selection I'll open up
another Curves layer. Before, our mask was inverted, but now, in this mask, the shadows and midtones are in a logical order. The shadows are dark, the
darker midtones are darker than the brighter midtones. So when we blend using this mask, we will completely retain our contrast.
Let's go through the blending process so you can see this in action. Firstly we'll delete these two Curves layers and go to our Channels Palette, and select
Midtones 3 by holding Ctrl, or CMD on a Mac, and left-clicking on the thumbnail.
We're choosing Midtones 3 because it has a great selection of midtones available to us. With this selection we'll subtract Darks 4 by holding Ctrl+Alt, or
CMD+Option on a Mac, and left-clicking on the thumbnail. We'll do the same for Darks 5 and Darks 6. With the Midtones 3 selection we can see that some
of the sky will also be included in the mask. We can remove this by subtracting a Brights mask. Brights 4 looks ideal because none of the midtones will be
affected, but a lot of the sky will be. Let's subtract this mask too, by holding Ctrl + Alt, and left-clicking.
Our mask is now ready. We've chosen the midtones and removed the shadows and highlights. Press Ctrl+H to hide the marching ants. To mask, we need to
set our brush at around 50% opacity, because the brighter exposure is extremely bright. Any stronger and the buildings would stand out too much.
Set our foreground colour to black, because we're masking out, rather than masking in, and in one pass, we will mask out the buildings, and the sky in the
top left hand corner.

Press Ctrl + D to deselect the mask, set your paintbrush to 100 and paint the water freely. This gives our sky and water an even balance. We may change this
later, and darken the water, but blending the exposures now gives us more options later.
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Finally, I feel that the shadows along the water line are too dark. Let's make a very small selection of these shadows by going to our Channels palette,
choosing Darks 5 and then subtracting Darks 6 so that we can maintain some contrast in those areas. Hold down Ctrl+Alt and left-click to subtract the mask.
It looks like the selection has disappeared and we get a new dialogue in front of us. Just press okay. The selection is still active, it's just very small. With our
brush still at 100, let's now mask out these very dark areas. And that's the blending process almost finished.
If you're not aware of this technique, you'll be amazed at how quickly we can blend in the city lights from this exposure. Just go to the Blend Mode of the
blue hour layer and change it to Lighten. Everything will disappear apart from the lights. This blend mode keeps only brightest pixels between the two layers,
which in this case, are the city lights.
They're a little bit strong in some parts. Press Ctrl + D to make sure you have no selection active and create a mask. With your bush opacity at around 25%,
mask out some areas that are too bright.

Let's merge these three layers by selecting them all, and pressing Ctrl+Shift+Alt+E. Now let's group our exposures, which we'll call Blended.
The next step is color correction. There's a strong pink colour cast in our image from the ND filter I used. I love the pink clouds but I think it's a bit strong in
the buildings. Let's correct this manually by opening up a Curves layer.
Zoom into where we consider to be close to 50% grey, choose the grey eyedropper, and select this area. Our image has now lost much of that pink cast.
Let's apply this selectively to our buildings and only lightly to our sky. Since we want to mask out the sky from this layer, we need to create a selection that
includes mainly the sky. We don't have to be too precise with this since the changes are small. In our Channels, Brights 3 looks great, as it selects much of
the sky but little of the foreground.
With our brush set to 100, we can now mask out the sky. We can go over it a couple of times to strengthen the effect.
Now let's mask out the water freehand. Press Ctrl+D to deselect the mask, set the brush opacity to 50% and paint the mask out. We can also mask out some
of the sky in the top left hand corner too.
We're now going to give more drama and energy to our image, just as we did last time, with Color Efex Pro Contrast filter.
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Let's first protect our shadows and highlights, and then bring up Dynamic Contrast to around 60%. We can give our image a bit more contrast by bringing up
Correct Contrast to around 15%. Now let's press okay.
If there are areas that we don't want affected by this new layer, we can just mask them out. For example, if you feel the shadows have been darkened too
much, just paint over them.
This one change has given our image more life and energy.
I think we should darken the water slightly, because generally water reflections do appear darker. We can do this easily by selecting the Polygonal Lasso tool
setting the feather to 0, and drawing around the water.
Next we open up a Curves layer and lower the upper midtones.
If the selection looks too strong along the water edge, we can refine the mask and create a smoother transition. Right-click on the Curves layer, choose
Refine Mask, and slide the feather to the right to create a smoother transition. The darker water looks a lot better now, and certainly more natural.
The midtones and shadows are starting to look a little bit too dark here, so let's go to Channels and make a Midtones selection with Midtones 3.
Open up a Levels Adjustment layer, and slide the midtones left to around 1.23 to give those tones more brightness. And we can mask out those changes in
the water, which we want to remain dark.
To finish the image, we just need to create a simple vignette. This time we can do it with a Rectangular Marquee tool, and set the feather to 300. Drag from
top left to bottom right, we then need to invert the layer, and open up a Curves adjustment. We can bring the upper-midtones down.
There'll be areas that we will want to mask out, like in the water which is already dark and has a natural vignette, in the buildings, and maybe some areas in
the sky.
And that's our finished image. We've extended our skill-set for overcoming the challenges of blending darker exposures. In the next tutorial we'll look at why
and how to blend 3 exposures in a highly contrasting scene.
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10.Blending With 3 Exposures
In this workflow, we'll look at how to blend 3 exposures, and why it's important to have more than 2 exposures when shooting scenes of high contrast.
We'll begin by dragging our 3 exposures into Adobe Camera Raw. We only have a little bit of preparation to do here. Firstly we're going to deepen the
highlights in the darker exposure because they're a little bit too bright. We'll set highlights to -15.
Next we'll select all 3 layers and add more warmth to the scene. Currently there's a slight blue cast over the image which is creating a pink/purple
foreground. Let's move the Temperature slider to around 7800 to restore some of those natural, warm tones.
We'll make the usual lens correction adjustments, and then we'll open up our images.
Using the Move tool drag our two exposures onto the middle exposure, placing the brightest exposure on top.
Now close the other two windows.
Before we begin, unlock the background layer. Then zoom into the horizon and place a ruler on there. You can see it's not straight.
Zoom out. Select all three layers, right-click and choose link layers. Select one of the layers and go to Edit>Transform>Distort, and just bring the bottom right
corner down slightly.
Now the first thing we'll look at is how difficult it is to blend two exposures that are contrasting. If there are too many stops of light between exposures, the
blending will look unnatural.
For example, let's make the background layer invisible and create our masks from the brightest exposure. Create a white layer mask on this exposure too.
Our goal is to blend in the sky from the darker exposure. So firstly go to our channels and choose Brights 4, which has a good selection of the sky.
Go back to our layers and start to mask in the darker exposure, you'll notice that it all looks very strange. The foreground and background look like they're
from difference scenes, and we have this edging along here around the arch.
I'll undo this.
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And this time we can try it with a less restrictive mask, like a Brights 2 instead, to see if that helps to create a smoother transition between the exposures.
And we'll starting masking again.
But just as before, the blending looks very unnatural. This is why we need a middle exposure to bridge the gap between these extremes.
Instead of combing the sky from one image with the foreground of another, we use a single layer as the main base, and simply blend in areas from different
exposures to create a balanced scene.
Let's start from the beginning by removing this mask, and making the top two layers invisible, while making the bottom layer visible again. Delete our
current luminosity masks and create a new set from the base layer.
Make our top two layers visible again and add black layer masks to them. Now let's go to our Channels palette. At the beginning of the digital blending part
of these tutorials, I said I preferred to use less restrictive masks when blending exposures. I'm going to show you what I mean.
Like before, we want to isolate the sky and blend in the sky from the darker exposure. Let's go to our Channels.
Looking at Brights 4, we have a decent selection of the sky. Let's choose it by holding Ctrl, or CMD on a Mac, and left-clicking on the thumbnail.
Returning to our layers, and with a white brush selected at 100% we can now begin to paint in some of the darker exposure.
The problem you see is that the ridge in the horizon is too light. In an ideal blending process, we would blend in some of the darker exposure in that area, so
that it changes brightness to fit the sky around it.
Let's undo our changes and go back to our masks. So now what we're looking for is not just a selection of the sky, but also a partial selection of the ridge too.
We need it to be a light-ish grey in our mask.
We could use Brights 1, but we may also affect the arch at the top. Instead, looking at Brights 2, the sky is nicely selected and the ridge is grey, while the arch
will be protected from our changes.
Select this mask by holding CTRL, or CMD on a Mac, and left-clicking on the thumbnail. Return to our layers panel.
Let's paint the darker exposure in again. And now you see the ridge darkening beautifully so it looks natural against the sky.
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Now it's time to blend in some of the brighter exposure, so that we can brighten our foreground and the canyon down below.
We really want to maintain the lovely details in our arch, and the best way to do that is with a midtones selection. Even if we subtract darker masks, as we
did in a previous tutorial, we may lose some of that important contrast, and flatten the details.
In our Channels, If we go to Midtones 3, which is what I normally use, we can see that there is a good selection of midtones but some parts of the sky and
ridge will be selected. We can select this by pressing Ctrl+Left-clicking on the thumbnail.
Let's see if we can subtract from this selection some of the sky and the ridge. Brights 2 is what we used before, and it looks like a good match. It shouldn't
subtract any of the midtones we wish to keep. Let's subtract this mask by holding Ctrl+Alt, or CMD and Option on a Mac, and left-click on the thumbnail.
Let's hide the marching ants.
Let's across the image. Unfortunately we haven't made a completely accurate selection. This ridge has brightened too much. So we have to paint carefully.
Firstly, undo this. Now lower the opacity to around 50%, with a brush size of about 1100, and paint across the top of the arch and the near foreground.
Now make your brush smaller to around 350, zoom in and start painting under the arch. Go over some areas a couple of times if needed.
Now zoom out and begin painting in some of the canyon below.
Let's look at a before and after. That's much better. If you see any parts that look inconsistent, mask them out.
We'll merge these three exposures by selecting all three and holding Shift+Ctrl+Alt+E. Select all three layers again and group them. We'll call this Blended.
The first change we'll make with this new layer is to clean up some chromatic aberration. Camera Raw usually does a very good job but in scenes like this,
with such a beautifully strung sunrise, we often get red fringing.
But it's very easy to clean up. Press Ctrl+D to make sure no masks are selected, and zoom right into the area with chromatic aberration. All we need to do is
replace this colour with a more appropriate colour.
To do this let's select the Clone Stamp, make it small enough, and set the opacity to 100. To make sure we're only affecting colours, change the Blend Mode
to Color.
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Now, just below the chromatic aberration, hold Alt, or Option on a Mac, and left-click to select the area you want to clone.
Move up to the affected area and just paint along it. Just like that we can replace the colour.
To the left, we can do the same but you see at 100% opacity the colour isn't right.
We can lower it to 50% and gently clone the colour in. Make sure you don't go over the edge on this part.
And that's it – much cleaner.
Next we're going to add a general Curves layer to introduce some more brightness and contrast to the image, which is a bit dark at the moment.
I'd like to give the some extra energy to the sun and have it spilling across the canyon to the left and the foreground here too.
To do that we can grab the lasso tool, set the opacity to 100 and draw around that area. Open a Levels adjustment and move the highlights slider to the left
and the midtones to the left too.
Mask out some of it if you feel it's too strong or if it's blowing the sky out too much.
The before and after shows a big difference, which adds an extra touch of energy to our scene.
This was shot just before the sun made it over the canyon to the left. In a few minutes the bottom of the arch to our right will light up with a golden glow.
Let's create that effect by firstly choosing the Quick Selection Tool, making the Brush size about 70, and making sure Sample All layers is selected.
Now just run the selection tool across most of the arch to select it. Next open a curves and brighten the arch while bringing down the shadows.
We only want to affect the underside of the arch, so set your paintbrush to black and paint the unwanted areas out at 100%.
This one change will add extra mood to our image. Next we want to make a very small adjustment to the foreground on this ledge, to make it consistent
with the changes we made to the arch. We want to brighten these areas slightly, so that they look like they're also bathed in the sun.
We're going to create a non-destructive dodge and burn layer by creating a new layer. Then we go to Edit>Fill and choose the 50% Grey option. We change
the Blend Mode of this layer to Overlay. Now we can dodge and burn on this layer non-destructively.
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Choose the Dodge tool, set the brush size to 350, make sure you're targeting highlights and set the opacity to 10.
Now gently dodge the front part of the foreground and to the right.
Next we need to exaggerate the shadows slightly, so we'll choose the Burn tool, set it to shadows, 350 size, and make the opacity 30%. Now we can burn
around the dodged areas to create some shadows.
Let's merge the adjustments we've made so far, by pressing Ctrl+Shift+Alt+E. Now select the adjustments and again put them into a group called Contrast.
We're going to make two adjustments with Nik Color Efex. Previously we've made these adjustments at different points in our workflow. Instead, we're
going do them at the same time and put them into a group called Nik. This makes our non-destructive workflow much easier to work with.
Our first change will be to pull out detail in the foreground here, which will add another dimension to our image.
Let's open up Color Efex. Now we'll go to Detail Extractor and just press okay. This works differently to the Detail Enhancer actions we have. Here we're
adjusting even finer details, which is ideal for our foreground. This process does create a lot noise, so be careful about when you use it.
Create a black layer for this mask by holding Alt and left-clicking on the Add layer mask button. With our paintbrush set to white, and opacity at 100, just
paint the details in.
There's a nice difference in the before and after.
Now we have to merge these layers, and open Color Efex again. Like we've done in other workflows, we're going to shift the light source towards the centre,
brighter part of the image.
Once you've selected Darken/Lighten Center, just press okay. We don't need to change any of the settings.
Once this is done, create a white layer mask and just mask out the bottom of the arch, which we want to be brighter.
Finally we're going to create a vignette, just to pull attention away from our foreground. Select the Rectangular Marquee tool, and with a feather of 250,
drag from the top left to the bottom right. Press Ctrl+Shift+I, or CMD+Shift+I to invert the selection and open a Curves layer. Just bring the midtones down.
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Next select the black brush and mask out all of the vignette apart from the foreground, here.
Group our Nik changes into a group called Nik.
And then group all of our adjustments into a big group.
And let's see the before and after. Now we have beautifully balanced image, with mood and energy.
As you can see, having a 3rd exposure can be of incredible importance in the blending process. So when you're out in the field, try to capture more exposures
than you think is necessary, just to make sure you have all options available to you when post-processing.
In the final workflow, you'll learn how to blend exposures naturally using Photoshop's 32bit process, and how to then finish the blending process
with luminosity masks.
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11.32 Bit HDR Combined With Luminosity Masks

In this final digital blending workflow, we're going to look at combining luminosity mask exposure blending with a different exposure blending method.
Please note that this is more of a bonus tutorial. You could easily blend the exposures we'll be working with using just luminosity masks, but I wanted to
show you another option. So if you don't have a modern version of Photoshop and Adobe Camera Raw or Lightroom, and can't follow the digital blending
part of this tutorial, it is not a serious problem. You already have the skills to create the blended image by blending with luminosity masks. But certainly
watch the video anyway, to see if you can gain some new ideas.
32 bit HDR processing is a relatively new concept. Essentially we combine multiple exposures to create almost a Super-Raw file, which holds potentially
more information. Unfortunately our monitors don't have the capability to view 32 bit HDRs, so once we've created one, we have to use Adobe Camera
Raw or Lightroom to adjust it to suit our monitors, and then eventually convert it to 8 bit or 16 bit for processing in Photoshop.
In years to come 32 bit HDRs will be a great option for easy, natural and sharp HDRs. Right now, the technology and software isn't quite good enough for us
to take advantage of these files. For example, we are often left with over-exposed areas that we can't recover when we edit in 32 bit mode. And for that
reason we can combine them with luminosity masks to complete the blending process.
To begin our 32 bit HDR workflow, we go to Photoshop, File>Automate>Merge to HDR Pro. Then we go to Browse and we choose the two files we're
working with. Photoshop will now merge the two layers for us.
On this screen we just need to select 32 Bit Mode and Complete Toning in Adobe Camera Raw. Press Tone In ACR.
You should now have Camera Raw open. The first thing we need to do is raise the Shadows all the way up. We can see that the sky is over-exposed, but
when we lower the Highlights, the sky looks a bit dull, and life-less. We're going to leave the highlights at 0. To finish we'll choose remove chromatic
aberration.
With our image in Photoshop, we now have to convert it to 8 Bit or 16 Bit, because Photoshop can't edit 32 Bit files. I would usually edit in 16 Bit Mode, but
to make sure things run quickly during this tutorial, I'm going to edit in 8 Bits. I'll do this by going to Image>Mode>8 Bits.
In the dialogue that appears, choose Merge.
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In the new dialogue, go to Exposure and Gamma, and then press OK. We now have our image ready for editing.
Let's recover some of that sky first. We're going to get the sky from our darker exposure. Go to our folder and drag in the file called Dark. In Camera Raw
we'll pull our highlights down to around -50, so there's plenty of information there, and we'll remove chromatic aberration. Choose Open Image.

Our new layer will be on top. Drag it underneath. We'll create luminosity masks from our 32 Bit layer because it has more information for our masks to
work with.
Now create a white layer mask on this layer.
You'll remember that in Camera Raw when we were editing the 32 Bit file, that I returned the Highlights to 0, instead of keeping them low to retain more
information. This is because since we were planning on blending that area from a darker exposure using luminosity masks, I knew that we needed to keep
this area bright, so that it would be easier to create a good luminosity mask selection. If it was dark, we wouldn't have been able to make an accurate
selection because there wouldn't be enough difference in brightness between the sunset and the surrounding areas.
We can go to our Channels now and look at our masks. I think we have the potential to use two different masks here, Brights 2, or Brights 3. In both masks
the sunset area is nice and bright, so it will be selected in our mask. Why don't we test both, and see which one we prefer.
To select Brights 2, hold down Ctrl or CMD on a Mac, and left-click on the mask thumbnail. Back to our layers panel, choose the paintbrush and set the
opacity at 100%. Make sure the brush is big enough. Set your foreground to black and begin masking the sunset. Just go over this region once.
Since Brights 2 is a less restrictive mask, the effect is quite strong but is also affecting the sky to the left here. However, the blending process seems okay.
Let's undo this and do the same thing but this time with Brights 3.
On this occasion, even though Brights 3 is more restrictive, it is doing a better job at smoothly blending the exposures.
That's the blending process finished, let's merge our layers non-destructively, by holding Ctrl+Shift+Alt + E, or CMD+Shift+Alt+E on a Mac.
Let's group those first two layers in a group call Blended. Press Ctrl+D to make sure no selections are active.
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The first thing that we notice with this image is the terrible yellow colour cast along the sticks and rocks. This was from a street behind me. It's easy to get
frustrated with these things, however, we can also look on the positive side. This yellow cast has given us a great way of making an accurate selection of
these sticks, in case we want to apply any special adjustments to that area.
Let me show you what I mean. Let's go to Select>Color Range. Here, we can make selections based purely on color, as we did in the seascape tutorial
earlier.
Choose the middle eyedropper tool with the plus sign and click anywhere on the yellow sticks. Set your Fuzziness to 50. Now keep clicking on the various
shades of yellow until it looks like we've made a good selection. Once you're happy, press OK.
Open a saturation layer, but don't make any changes. Instead, let's look at our mask by holding Alt, or Option on a Mac, and left-clicking on it. We can see
the sunset area is selected, which isn't what we want.

Choose the zoom tool and zoom into that area. Next choose a black paintbrush with a smallish size, and start painting out the horizon. We are painting
directly onto the mask here. Be careful not to go near the sticks. But it doesn't have to be perfect.
Now zoom out and click on the layer below to make the mask disappear. Now let's save the selection because it will be useful later. Select the mask by
holding Ctrl and left-clicking. Go to Select>Save Selection and call it Sticks. You can see this selection in our Channels palette with our luminosity masks.
Press Ctrl+D to deselect the mask and go back to your saturation layer. Bring the general Saturation down to -65. If you see any areas that still look at bit
yellow, change the brush to white and paint in that area on the saturation layer.
Our sticks have now lost the yellow cast, and have retained a more brownish colour, but they don't have much life or detail. Just like we did in the last
tutorial, we're going to add very fine detail using Nik Color Efex's Detail Extractor.
But first, Ctrl+left-click on the mask of our saturation layer to reselect the mask, select our merged layer, and now open Color Efex.
Choose the Detail Extractor Filter and leave the default settings. Just press Okay.
We now have a new layer, with only the sticks and rocks visible. Look at the before and after. We've just created some beautiful texture from that one
change. When working with seascapes, I love to contrast the texture of rocks and sticks against the various water textures.
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Down the right hand side here you can see an area which we don't want to include in the detail enhancer, so we'll create a mask and mask that out.
Our image has some lovely colours but at the moment they're a little bit flat. Let's open a Vibrance layer and increase vibrance to around 70. This will
enhance most of the colours, but especially the subtle colours in the scene.
You can see that this has affected the colour of the sticks, which we don't want, so let's reselect our mask from before, by pressing Ctrl+left-clicking, change
our brush to black and begin brushing over those areas in the Vibrance layer.
The sticks are still a little bit too dark compared to the rest of the image. The last mask should still be active, so open up a Curves layer. You can see the
mask has been applied to the Curves. Now just bring the curve up until you're happy.
If the stick to the left is too bright, mask it out.
Now we're going to add more energy to the sunset and the sunset area. Just like we've done before, create a new layer. Select the paintbrush, set the size
to 1400, and opacity to 100. Now click on the foreground colour. Drag your cursor onto the image. It'll become an eyedropper. Select a yellow/orange area
close to the sunset. Then press Okay. Now gently paint in the sunset area, without going over the sticks.

Change the Blend Mode of this layer to Overlay and reduce the opacity to 40. This will add more colour and energy to the sunset. We'll do this again to add
more pinks to our sky.
Open a new layer, click on the foreground colour, and manually choose a pink colour. This time paint around the sunset and in the water. Change the Blend
Mode of this layer to Soft Light, for a softer effect, and reduce the opacity to 25. If you feel it is too pink in the foreground, create a mask and gently mask it
out at a lower opacity.
Since we only want this to affect the sticks, let's choose the selection we've already made. Delete the current mask on the color balance layer. Select the
mask for the sticks, and then choose Add layer mask.
The final step for these adjustments is a simple contrast adjustment using a Levels layer. We're just going to slide the shadows along to the right, to deepen
the shadows and lower midtones a bit more.
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We're now going to select all of these adjustments and merge them by holding Ctrl+Shift+Alt+E. Reselect these layers and put them in a group called
Changes.
To finish the image we are going to return to Nik Color Efex. We just need to shift the light towards the sun, and create a small vignette.
As we've done before, select Darken/Lighten Centre, but this time change the Shape to an oval, place the centre at the top of the sticks, and brighten up the
border luminosity slightly. Press Okay.
If the vignette is a bit too dark in some areas, we can create a mask and paint it out.
Let's group all of our changes to see a before and after. What a huge difference. We've controlled the terrible colour cast, softened the contrast
throughout, added some lovely detail to the sticks, and given the image some beautiful colour and mood.
In the final video we'll look at how to blend more than 3 exposures, why that is necessary sometimes, and we'll talk more about refining masks.
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12.Finishing Touches

In this final video I just want to show you two more things that will deepen your knowledge of luminosity masks.
Firstly we'll look at how and why to blend more than 3 exposures. And finally, we'll look at a great little dodge and burn technique to refine your masks even
more.
Blending more than 3 exposures
On a couple of occasions I emphasised the importance of blending with exposures that aren't too contrasting. In other words, we can't blend an image
naturally if there are too many stops of light between exposures.
We looked at how a middle exposure can sit between two extreme exposures and act as a bridge between them in the blending process. Sometimes, in
scenes of extremely high contrast, we may choose to blend even more exposures. The highest number of exposures I've used in one image is 5 but, I'm sure
it could have been done just as smoothly in 4.
As usual, I'd prefer to show you what I mean rather than talking about the technicalities.
So let's take the four exposures from Petra into Photoshop. We can look at each one and notice that they are progressively darker. Each time the lanterns
become less over-exposed, and gain more information in them.
Now we can layer them, but make sure to place the brightest exposure on the bottom, and with each layer going up, the exposures get darker. So on top we
have the darkest exposure.

Let's align these layers by going to Edit>Auto-Align.

Our goal is to give the lanterns in the foreground more information, which we'll take from the darker exposures.
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The brightest exposure is easily the best one to run our luminosity masks on because it contains the most information. So let's do that.
Now let's make the two middle layers invisible and add a black layer mask to all of the darker exposures by holding Alt, or Option on a Mac, and Add Layer
Mask. Go to the Channels Palette, and let's look at the Brights channels. We want a mask that isn't too restrictive but which targets only the lanterns. Brights
4 looks a bit too restrictive, but Brights 3 looks ideal.
Let's make that selection by holding Ctrl, or CMD on a Mac, and left-clicking on the mask thumbnail. Now go back to our layers panel and choose our top
layer. We're just going to focus on this lamp in the front. Select a white paintbrush and put the opacity to 100.
Start to paint over the lantern close by.

Obviously this doesn't look good. Let's undo this and change the opacity to 20, which is what we'll use later. It's a slight improvement, but now the lamp
looks flat. Undo this again.
Instead, we're going to gently blend in the other exposures, so that we make a perfectly smooth transition between the various tones in the lantern.
We should still have our selection active. So let's make the two middle layers visible again. This time we're going to blend the brightest of the dark
exposures. With a white brush selected, and the opacity at 100, just paint in the area of this lantern.
And you'll see a very small change. But some information will be nicely restored in a natural way.
We'll move up to the next layer and do the same, which brings back some beautiful detail.
And finally, going to our darkest exposure, lowering our brush to 20 %, we just need to paint once over the lantern to make it perfectly exposed for.
And that's it. By gradually blending exposures we can restore information in the most extreme scenes of contrast. You can apply this to other situations too.
If you have 5 or 6 exposures of a highly contrasting sunset, you can use 3 or so exposures just for the sky, and then 2 or 3 exposures for the foreground.
There is huge potential for luminosity masking, but it all depends on how experimental you're willing to be with them.
Refining masks – Dodge & Burn
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SET UP SEASCAPE, MASKS.
You'll remember this workflow from a videos back. We were faced with the problem of using Darks masks to blend in underexposed areas. To overcome this
we subtracted masks, however, there's another way to overcome this challenge. It's a little bit more time consuming but you never know when small things
like this can help you out.
Last time we used Brights 2 to select the darker areas, but it took some of the contrast out of our images. Let's do that again.
We'll select the mask in the Channels palette, go back to Layers, choose our paintbrush, set the background to white, the opacity at 100, and mask over this
area once.

Just as before, it's very flat. This time we'll zoom in on the seastack and hold Alt, or Option on a Mac, and left-click on our mask. The mask now appears.
In the areas of the seastack we have shadows, midtones, and some highlights. Because of this, we can actually use our Dodge and Burn tools to refine the
mask to suit us.
On this layer we are trying to bring through the midtones and highlights on the rock, from the brighter exposure. We want to keep some of the shadows
from the darker exposure, so that we retain more contrast.
This means that we want to make the midtones and highlights in our mask darker, while brightening the shadows. It sounds confusing, but let's see it in
action.
Firstly choose the Burn tool. Set the Range to Highlights and the Opacity to 100. Now just paint over the left side of the rock
You can do this multiple times until you're happy.
Next you can do exactly the same but now with midtones, until you're satisfied.
Let's click on our layer now to look at the result. You can see that this side of the rock now has much more contrast and looks much better.
If we want, we can even select our Dodge tool, choose Shadows, and run that over the same part, which will give us even more contrast. We don't have to
be looking at the mask to use this dodge and burn technique. We just need to make sure the mask is selected. And that's it! Another handy tool to help you
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in your journey to digital blending mastery.
This concludes your advanced luminosity mask training. If you've watched this series in a short space of time, you may feel overwhelmed. There's a lot to
take in, and this really is one of the most advanced Photoshop techniques out there. My advice is to go and experiment with your images. You'll come up
with challenges and questions, and when you do, return to the course a few more times. Then you'll have a greater sense of how to adapt all of this into
your workflow.
I want to thank you, firstly for purchasing the course, and for sticking with it through to the end. If you have any questions, or would like to say a nice word
or two about the course, or comment on my strange accent, please feel free to connect with me via facebook. Just look for Jimmy McIntyre and you'll see
me there.
Good luck with all of your photography endeavours, and I'll see you around.
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